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Appendix A:

PHAM Basics
This appendix covers PHAM’s Purpose, Set-up & System Requirements,
PHAM Tour, Export Capabilities, and Behind the Scenes: Functionality.

A.1. PHAM’s Purpose
PHAM, Pelagic Habitat Analysis Module, is a geographic information system (GIS)
integrated with a variety of viewing, analyzing and data storing capabilities. Specifically
designed for marine and coastal applications, PHAM has been successfully used in a wide
range of applications from resource management and oceanography, to pollution studies
and coastal monitoring. Unlike other GIS software, PHAM goes beyond latitude and
longitude to include both depth and time. By incorporating these two extra dimensions,
PHAM’s capabilities provide scientists, resource managers, companies and educators with
the tools to better interpret and communicate their ideas.

A.2. Set-Up & System Requirements
PHAM has been developed for use in Windows
Operating systems and requires a minimum allotment
of free memory (see table to the right). The installation
of PHAM is automated through the website.

System Specifications:
Pentium PC running at 100 Mhz
(minimum)
500 MB available disk space
(minimum)
64 MB RAM (minimum)
Windows NT 4.0 operating system
Microsoft ACCESS

Basic installation will include all available services
(discussed in Appendix B) as well as bathymetry and a
practice project. When the installation finishes, you
will have a folder under your C drive named
EasyPhamLite as well as a shortcut to the application on your desktop.

A PHAM Demo project is also available for download. This download includes a project complete
with imagery. This project is a great way to get started in PHAM. Simply, follow the step-by-step
instructions included in the QuickStart Guide using the practice project.

A.3. PHAM Tour
Upon start up, the display consists of a map complete with an overlaid latitude/longitude scale
grid, land masses, and bathymetry. A typical view of the start-up screen can be seen to below.
The Main Menu consists
of 7 drop down menus.
The first menu, File,
contains all functions
pertaining to bringing data
in or saving data out. If
you want to change data
already in the project,
turn to the Edit menu.
Check out the View menu
to change what and how
data are displayed. Zoom
menu contains all the
zoom and centering options. To analyze the data, look in the Process menu. Window menu
works to arrange any plots made within PHAM. Help menu holds all tips and guidelines for
success in PHAM.
Next on the tour is the
Main
Key
Function
Main Toolbar. Situated
Toolbar Icon
Short-cuts
near the top left of the
Create New Project
Ctrl-N
application window and
Open Project
Ctrl-O
beneath the Main Menu,
Save Project
Ctrl-S
the Main Toolbar
Print Screen Graphic
Ctrl-P
provides shortcuts to a
Zoom to drawn Window Box Extent
Ctrl-W
range of commonly used
Fixed Zoom In
Ctrl-down
tools. In many cases,
Fixed Zoom Out
Ctrl-up
these tools also have
Set New Map Center
Ctrl-Z
keyboard short-cuts as
Refresh Screen
well. The table below
Execute Polling Function
provides a brief
Control Simulation
description of the tools
PHAM Version Information
Ctrl-M
featured in the toolbar as
PHAM Help Menu
Ctrl-A
well as their keyboard short-cuts. More in depth descriptions of these tools can be found in their
respective appendices.
The banner along the
bottom of PHAM’s window
contains both a Messaging
Panel and a Status Bar.
Information on ongoing
processes or the outcome

of a process can be found in PHAM’s Messaging Panel. The Status Bar
contains the information in the graphic at the top right of this page.
Information on the data plotted (aka data blobs) can be attained by
double clicking on the blob of interest (shown to the right).

A.4. Export Capabilities
A.4.1. Measurement Export
This step will take a few minutes, so please be
patient. To export your data with the matching
satellite imagery, navigate to the View menu then to
Spatial Analysis Options.
Select the measurement type of interest by finding
and clicking on it in the first Category box. Then
manually set the appropriate date span by typing the
earliest date in the first box next to Date Range and
then the latest date in the last box next to Date
Range. To set the geographic extents, you can either
type in the minimum and maximum latitudes and
longitudes in the appropriate boxes or you can hit
the Window button and simply drag your mouse over
the area of interest.
Finally, select the imagery you would like exported in
the second Category box. For each imagery set make sure to fill out the appropriate binning to
use and whether or not you would like the data smoothed.
When finished preparing, click the Export button.
Once you click this the dialogue box to the right will
appear, here you will need to select the Parameters
you would like exported. To name the file, click the
Export File button and type in the name of the file.
Then click the Apply then the Ok buttons.

A.4.2. Map Export
To export a map, select File-Export-View, name the file, and save. The maps can be exported in
the following formats: .bmp, .gif, .jpg, .png, .tif, *.gif.

Appendix B:

PHAM GIS Services
This appendix is divided into two sections: Map Customization and Services.
Map Customization covers Map Settings, Overlays, and Credits; while
Services covers Configure Services and Available Services & Descriptions.

B.1. Map Customization
B.1.1

Map Settings

Basic map settings such as grid formats, units, turning on
or off annotations such as legends, projections, etc can
be found under View-Display-Settings-Settings tab
(shown to the left). This section simply goes through all
the options contained within the Settings tab.

Units Box
-Distances: Option to select either metric or English units
-Lat/Lon: Option to choose between 4 different formats of
latitude and longitude: decimal degrees (dd.f), directional degrees
(N dd:mm.ff; N dd:mm:ss), and radians.
Legends Box
-Options to turn on or off Birdseye, Credits, Legends, Compass, and
Scale Bar
-Compass: Select color by pressing on the Compass button
-ScaleBar: Select color by pressing on the ScaleBar button
Projection Box
-Drop Down Box: Options include Mercator, Lambert
conformal, or Arc
-Grid Lines/Labels: Grid lines and grid labels can be
displayed or hidden by checking the boxes to the left of Grid
Lines and Grid Label buttons. The color of the grid lines and
labels are selected by pressing the buttons

Display Sizes Box
-Global zoom scale: Interval for the fixed zoom
-Blob count/value scale: Default scale of the Blob count/value
-Point size scale: Default scale of the GIS points
-Text size scale: Text size for all identifications labels (e.g. Station
Ids)
-Line width scale: Default scale of the GIS lines
-Line filter: Option to decrease the resolution of the imagery in
order to increase the uploading speed. This number represents
the number of lines to aggregate into 1. The default value is 1.
Background Colors Box
-Screen: Option to select the color of the screen background
-XY Plots: Option to select the color of the lines on the xy plots

B.1.2. Overlays
Overlays are the map shapes and features that have
been either created in or imported into PHAM. To
modify the way these shapes and features are
displayed go to View-Display Settings-Overlays tab
(shown to the left).
In the example to the right, Points will appear on top
of WDB Rivers with country as the bottom most layer.
This order can be changed by clicking on the arrow
buttons to the right of the Overlays box.
Selecting the overlays to display is done by clicking
on the name of overlay. All overlays that are
highlighted in blue will be displayed on the base map.
To display or remove all of the overlays click on the
All or None button, respectively.

Appendix C:

Data
This appendix is divided into two sections: Understanding the Data Fields & Display.
Understanding the Data Fields covers the Data Hierarchy and Logic behind
the Hierarchy; while Display covers Filters, Blobs, and Plots.

C.1. Understanding the Data Fields
C.1.1. Data Hierarchy
Within PHAM, the data is stored in the
hierarchical structure shown above.
When planning out the way your data
should fit in PHAM, it is important to
consider how many levels are included in
your dataset and what you would like to
be able to filter on.

The hierarchy is quite flexible as to what you include in each field. The key to success is to keep
the relationships between the variables in mind when assigning data to them. The graphic
below shows the Access database relationships of all the variables in the PHAM data structure.
Understanding the relationships shown here is much easier if the logic behind the structure is
understood. This logic is explained in the next section.

Database
Relationships

C.1.2. Logic behind the Hierarchy
When the database for PHAM was created, the designers looked at the data in the following
context:

Photo Credit: http://www.sea-ex.com/fishospeak/fishbowl.htm

For data to be collected, a voyage of some kind must take place. A voyage can be anything as
long as it is the primary source on which all the others depend (captain, observer, fishery, boat,
trip, etc) or can be found (dataset, logbook, field notes, etc).

Voyag

Once a voyage is established, stations can be visited. A station is simply a unique latitude and
e
longitude where data was collected. This is an optional field in PHAM. If the locations of data
sampling have special names, like Red Rock Island or Urchin Rock, then here is where you can
include those names. If not, then don’t sweat it- PHAM will name those places for you.
Once at a location, a sample can be taken. Sample can be equated to an attempt to collect
data, in the cartoon, the fisherman was on his 4th sample. All measurements taken are linked by
whether or not they were made on the same attempt. This column is optional as well, if you
don’t have special names for your attempts to collect data, then leave the column blank- PHAM
will take care of it.
What are you using to collect data? This is the sensor. It can be a hook and worm, like in the
example, or it can be a thermometer, net, or tag. This is basically whatever you are using to
collect whatever information you are interested in.

The depth of course is simply how deep the sensor was when it collected the data. This can
either be in feet or meters, but must be consistent throughout the data being imported.
What did you find? The measurement type is a description of whatever the sensor has
discovered or was supposed to discover. The measurement type is a category complete with
units that describes the numerical value your sensor has collected. This could be anything from
number of fish eggs to temperature of the water to number of hours your sensor was in the
water, and the list goes on.
To the final product… the measurement value...The measurement value is the data as described
by the measurement type. This is a number and is treated quantitatively- be it a measure of
effort or of catch or of temperature.
Hopefully, you now have a better understanding of how PHAM handles your data. The following
table should serve as a quick reference to answer your questions as you get your data ready to
be imported into PHAM.

C.1.3. Summary Table
Data
Field

Description

Ability to Filter On?

Voyage

Specifies the origin of the data (Example: “Observer
Data” or “CA Longline Fishery” or “Humpback Abundance
Survey 25”)

Yes

Station

Unique Name for each combination of Voyage, Latitude
and Longitude, (Example: “Block No 45” ). This field is
optional. If left blank, PHAM will assign station numbers.

Yes, option to include
only Active stations,
where a measurement
was taken

Date

Date-Time measurement was taken in the format:
MM/DD/YYYY hh:mm:ss

No

Latitude

Latitude in decimal degrees, South (-) and North (+)

No

Longitude Longitude in decimal degrees, West (-) and East (+)

No

Sample

Unique Name for each unique combination of Station,
Date, Sensor and Depth, Example: “Set No. 5”

No

Sensor

Category of Device put in the water to take the
measurement, Example: “Circle Hook” or “Gillnet”

Yes

Depth

Depth at which the measurement was taken either in
feet or meters- cannot be a combination of the two.

No

Type

Category of measurement taken, Example: “Swordfish
Catch” or “Leatherback Standard Carapace Length”

Yes

Value

Amount or Value of the measurement taken. Must be a
number

No

Units

Units associated with the measurement taken. Each
measurement Type should correspond with only one
unit.

No

C.2. Display
C.2.1. Filters
As discussed earlier, the displayed data can be a filtered version of the data in the database.
Filtering is accomplished under View-Display Filters. This dialog box has two tabs corresponding
to 2 different levels on which the data can be filtered.
Sensors tab: The sensors tab filters the data at the level of the sensor.
Simply highlight the sensors to display and click OK. The Select All
button will include all the sensors while the Clear button will not
include any of the sensors.

Voyages tab: The Voyages tab filters the data at the level of the voyage.
Simply highlight the voyages to display and click OK. The Select All
button will include all the sensors while the Clear button will not include
any of the sensors.

C.2.2. Blobs
PHAM uses blobs to display the data on the base map. The tools to modify the data blobs can
be found under View-Data Graphics-Blobs tab. Within this dialog box (shown below) is a Blob
type window, a Display Stations section, Type drop down menu, and boxes where the size of the
stations and blobs can be modified.

Blob type window: This holds all the measurement types
available in the database. The checked measurement types x
are the measurement types that will be displayed. To modify
the measurements, the measurement of interest must be
highlighted first. The colored boxes next to the Measurement
types represent the color of the measurement type. These
colors can be modified by double clicking on the color box and
selecting a new color, or by clicking on the ‘Fill Color’ and ‘Pen
Color’ buttons.
Display Stations section: Checking the box next to All will
display all stations while checking the box next to Active will
only show those stations that were sampled during the time period (This comes up during the
simulations (see Appendix D). If one of these boxes is checked, the stations will appear on the

map as plus signs. Data size/width options control the size and width, respectively, of the
station plus signs.
Blob type drop down menu: The options here are Pres/Abs, Count, Value, Count Pie, and Value
Pie.
 Pres/Abs basically shows a blob where the measurement value is not 0 and does not
show a blob if the measurement type is 0.
 Count will change the blob size based on how many times the measurement was made
at a station
 Value determines the blob size by the actual measurement value. When this blob type
is chosen, the adjacent drop down box will become available. You can choose whether
to display the average, sum, min, or max value measured at the station.
 Count/Value Pie will show a ratio of the different measurement types to each other at
the stations either by count or value.
Station and blob size can be changed by adjusting the values next to Station size and Data size
respectively. In addition, the Solid button creates solid blobs rather than circles.
The Shape button allows the user to set the binning of each
measurement type and to define the way each bin is represented.
To set a bin for a particular measurement type, highlight the
measurement type and click the add button Next to ‘Shape Style’.
Specify the range and corresponding size and color of the bin and
then click the box next to visible when you’d like it the bin to
appear on the map. *The visibility and choice of bins could result
in the misrepresentation of data in the final map.

C.2.3. Plots
Plots can be created in PHAM through the View-Display SettingsPlots tab. This dialog box provides the ability to add, modify or
delete X-Y graphs. Any plots created within PHAM will change
through time during a simulation, displaying the relevant data for
that time period (see Appendix D for simulations).
The data displayed in Depth Profile, Image Statistics, and Imagery
Profile can be set up by pressing ctrl, clicking on the screen, and
then dragging your cursor in a line. All points along this line will
show up in the plot.
The data that is displayed in Characteristic Distribution/Correlation, Sample Density Probablity
plots is set through Spatial Analysis (see Spatial Analysis).

Appendix D:

Imagery
This appendix is split in two sections: Import and Display.
Import covers Available Imagery, Configure Import Services, and
Category.
While the Display section covers Palettes, Browse Images, and
Simulations.

D.1. Import
D.1.1. Available Imagery
The amount and quality of satellite imagery is increasing rapidly and the scientific community is
scrambling to keep up with the vast number of satellite imagery formats currently being
distributed. PHAM, NOAA, and NASA provide website interfaces that allow free access to
oceanographic data, NASAPHAM, Coastwatch, and OceanColor Web, respectively. This section
will go over the three websites and then supply a summary table of the most popular satellite
imagery.

D.1.1.1 Website Imagery Interface
On the PHAM website imagery page
(http://phamlite.com/imagery.html),
there is a list along with links to
popular satellite imagery products that
have been completely set up for use in
PHAM. Links to the products included
in the table will bring you to the
Imagery Source website where you can
download the necessary files. This is a
very basic interface that only includes the links to the files of imagery sets that have
“pre-set” categories in the downloaded version of PHAM. To learn about these imagery
sets, follow the information links also included in the table.
If the desired imagery is not included in this list, there is still a good chance the imagery can be
used in PHAM. This will just take a little more effort and thought on your end. The PHAM
Formats table at the end of this appendix, sections D.1.2. Configure Import Settings and D.1.3
Categories are must-reads in order to incorporate imagery off this list.

D.1.1.2. NASA Website
NASA’s products are available at Ocean Color Web,
developed by the Ocean Biological Processing
Group (http://oceancolor.gsfc.nasa.gov/).
The
Ocean Color Web page is a “one stop shop” for
information on NASA satellite data collection,
processing, and products. Navigating the site can
be a bit overwhelming if you’re unsure of exactly
what you want. The data is organized by mission,
or satellite instrument, and by the level of
processing the data has undergone, rather than by end product.

The main NASA missions are the Coastal Zone Color Scanner (CZCS), the Ocean Color
and Temperature Scanner (OCTS), the Sea-viewing Wide Field-of-view Sensor (SeaWiFS),
Moderate Resolution Imaging Spectroradiometer (MODIS), and Medium Resolution
Imaging Spectrometer (MERIS). There are many factors to take into account when
choosing an imagery set such as spatial and temporal resolution. While all the missions
are global, they are binned at different spatial resolutions (4 km and 9 km bins) and the
dates of the missions vary as shown in the above table. Only Aqua MODIS and CZCS
have the option to choose from 4 km or 9 km resolution. The rest of the missions only
supply the 9 km spatial resolution. Information on the products and the algorithms
used to produce them can be found on the website under Documents-Data Products-L2
Products.
NASA provides links to the data at different levels
of processing so that the scientist has the option to
use their own algorithms to produce the
geophysical variables or to bin these variables. The
data levels are described in the figure to the left.
PHAM accepts imagery from levels 2 and higher.
Once a level has been decided upon, the data can
be downloaded either from the Data-Data Access
drop down menu in the menu or from clicking on
Data Archive found in the Data Access box on the
homepage.

D.1.1.3. NOAA Website
NASA’s products are available at Coastwatch
(http://coastwatch.pfeg.noaa.gov/coastwatch
/CWBrowser). This browser is a bit more
straight forward and definitely easier to use
(unless you have a long timeseries). Available
datasets can be found in the Select a data set
drop down menu. The names provide the
following information (from left to right):
variable, instrument, spatial resolution,
geographic region, and temporal resolution.
Location, spatial and temporal resolution, as
well as file format are customizable. If the longitude and/or latitude are not specified,
the data corresponding to the entire area in the map will be exported. The map extents
can be changed by clicking on the links at the bottom of the page. For help in choosing
the file format, check the PHAM Formats table at the end of this appendix for the
formats that PHAM is already set up to accept.

D.1.2. Configure Import Services
PHAM’s Imagery wizard works as a type of Rosetta stone that can
decipher over 50 satellite imagery formats (PHAM Formats) and
deliver the desired data in a familiar, readable form to the scientist.
Imagery can be imported into PHAM through the Configure Import
Services dialog box shown to the left. Within this dialog box,
there are 3 tabs: Images, Local, and Metadata. The Images tab is
specifically for single images, while the Local tab is for importing
many images located in a folder on your computer.
Each image or set of images is defined by a category. The
category contains information on the file format and the pixel to
data value relationship of the imagery. If the imagery set of
interest was downloaded from the PHAM website, then it will
already have a built in category found in the Category box located at the top of the Configure
Import Services window. The category name that corresponds with the imagery can be found on
the Imagery tab on the website (http://phamlite.com/imagery.html) in the category column.

D.1.3. Categories
Each imagery set is paired with a Category which is set up under View-Display SettingsCategories. The top box contains the names of all the previously set up categories. The Edit
button opens the legend and scaling fields for editing.
Category: name of category.
Image Format: format of the imagery
Import type: applies only to EOF data and zipped Modis files.
Measurement type: name given to the imagery.
Palette/Orient: imagery color scheme and color scheme
orientation.
Legend/Format: Disable the legend by clicking on the Enable
button (or vice versa), customize the number of Values
to include in the legend scale, and define the Height of
the legend box.
Type/Units/Fmt: describes the imagery. Type can either be
measurement, depth, or elevation. Units field is a user
defined field, meaning any unit can be typed into this
box as is appropriate (meters, deg C, etc).
Function: the equation used to convert the pixel value to an appropriate measurement value for
the imagery.
Offset/Slope/Con: the values for the variables in the Function box. The first is the y-intercept or
offset; the second is the slope of the line.
Scaling can be found along the axis of the graph at the bottom. *Pay close attention to the
scaling. This must be returned to the original scale prior to running Spatial Analysis.

D.1.4. Image Attributes
Information on a displayed image can be seen by
selecting View-Image Attributes. This will bring up a
dialog box (see left). The dialog box lists all the
metadata for the image file, and includes an option
to export the imagery metadata to a .csv file.

D.2. Display
D.2.1. Palettes
Each imagery set has a unique palette created to best
display the imagery. These can be selected by going to
View menu then Palette. The preset palettes can be
selected by clicking on the drop down button at the top
right of the screen indicated by the blue arrow.
To customize your own palette, you can change the colors
of posts by either double click on the black arrows, called
posts, or change the values manually by putting in the post
number and changing the values in the boxes next to Red,
Green, and Blue. To add and remove posts simply click on
the Insert Post and Remove Post buttons. The location of the posts can be changed by clicking
on the black arrows and dragging the post to the desired location.
The values next to the color bar can be either Pixels or Values. This can be changed from one to
the other by clicking on the box above the numbers (either Pixels or Values button).

D.2.2. Browse Images
The option to ‘browse’ through the imagery is one way
to view the imported imagery. Browse Images is a
static view of the imagery at a certain date. Click on
Process-Browse Images and the toolbar to the left
should appear. Choose the desired imagery by clicking
the first box’s dropdown button. Then scroll to the desired date by clicking the third box’s
dropdown button.

D.2.3. Simulations
Before you can run a simulation, there are a few set up steps that you
must complete. First, you need to select one of the imagery sets to
display along with the data. This can be done under View-Data
Graphics-Images (see left). Select your imagery by clicking on the
dropdown arrow next to the top left box.

The simulation start and end times are set up in the View-Display
Settings-Simulation tab (see right). The Date/Time Format drop down
menu allows you to select either Date or Date/Time. The Simulation
Start is the date(/time) of the first simulation frame. The Simulation
End is the date(/time) of the last simulation frame. The Display Delta is
the amount of time in between frames. The units on this time can be
anywhere from seconds to years.
To show the time and date of the current frame, select View-Status Window from the main
menu. While the simulation is running, the Status Window will show the time and date of the
current frame of data and imagery. Whenever the simulation is not running, the Status Window
shows the time and date from your pc clock.
The simulation is run through the control panel under
Process-Simulation Controls (see left). The play button
starts the simulation. The stop button stops the
simulation. The fast forward button steps forward frame
by frame. The home button resets the simulation and
returns everything back to normal function mode. In
order to return to normal functions, it is essential that
this button be clicked whenever the simulation is over. The Retain days value at the bottom of
this dialog box represents the number of days that PHAM will look backwards in time for an
available image to display with the data.

Appendix E :

Spatial Analysis
The Spatial Analysis tool within PHAMLite provides a method of collecting and analyzing
environmental data for statistical associations with study data. Where associations are found the
tool can be used to analyze habitat and make predictions of habitat based on environmental
parameters. This tool can be accessed through View-Spatial Analysis Options.
Data Collection / Measurement Tab
Sampling data loaded into EASy appears in the first list box of the Measurement section. The
list box allows for selection of more than one measurement type at a time. If more than one
measurement type is selected the data sets are grouped together and treated as the one data set in
the subsequent analysis.
Date, Latitude, and Longitude can be filtered by setting the desired Date and Location ranges.
Imagery to be compared is added into the Characteristic box.
The following values should be set only after considering the
temporal, spatial, and value ranges of your data and the
imagery associated with your data.
 Value Min, Max, Bins = The minimum and maximum
value of the imagery to include as well as the bins over
which the imagery should be grouped.
 Search,Days=How PHAM should search for the imagery
data for each record, number of days of search radius of
imagery
 The Anaylysis and Display Controls box has options to
weight the measurement values, set the histogram bins, and
normalize the data.
The EASy Spatial Analysis program provides a capability to
calculate spatial density images. These images represent the
relative geographic and temporal likelihood of finding the
measurement types selected based on the associated imagery data.
A density preference array is then compiled for one, two, or three
user selected physical characteristics. The array accumulates catch
measurements into user defined bins. The accumulated
measurements in the density preference array cells are then scaled
between zero and one.
To plot these density arrays select the Density Plot (see and
customize the plot using the Spatial Analysis Options-Density
tab.
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